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1. Open-box Inspection 
Check whether there is any packing damage. Refer to the shipping list for 

the integrity of the product. 

 

2. Product Introduction 
2.1 Brief Introduction 

Genizer Dual-Light Particle Sizer (GDPS) is a high-performance and 
general-purpose particle sizing instrument. With the technique of 
Dynamic Light Scattering (DLS), GDPS features high-speed digital 
correlator and high-performance photomultiplier tube as a core device, 
which have the characteristics of fast-speed, high-resolution, accurate 
precision, high detection sensitivity, as well as the advantages of not 
destructing structure of original nano-particles or contaminate testing 
samples. It can be widely used in pharmaceuticals, emulsions, ceramics, 
abrasives, nanoparticles, liposomes, inks, paints, dye, clay, lubricants, 
cells, bacteria, food, additives, graphite, fuels and etc. 
 

2.2 SPECIFICATIONS 

Catalog No. GDPS 

Description Dual-light Nano Particle Sizer 

Size Range 1nm-10μm 

Accuracy <1% 

Dimensions 250mm × 150mm × 460mm (9.8 in. × 6 in. × 18in.) 

Weight 15kg (33 Lbs.) 

Application Emulsions, Liposome, Ceramics, Abrasives, Inks, Paints, Nanoparticles 
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STANDARD FEATURES 

Control &Data 
Collection System Connecting to a computer with LPSA software 

Greenlight source Max. 30mW, 570nm 

Bluelight source Normal 10mW, 470nm 

Supply Voltage 110V/220V  50/60Hz 

Temperature 5°C -40°C±0.1°C 

Concentration Range 0.1mg/mL-100mg/mL 

Scattering Angle Vertical 

Sampling Time Less than Four Minutes 

Detector Photomultiplier tube (PMT) 

Warranty 1 year against any manufacturing defects 

 

OPTION FEATURES 

Power Supply Precision UPS voltage stabilizer 

Clean Ultrasound Washer 
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3. Safety Instructions: 

In this manual, the following symbols are used: 

Attention: Indicate the correct procedures and practices for 

operation, to avoid damage to the equipment or other properties. 

Warning: Potential Danger. Correct procedures and practices 

need to be followed to avoid personal injury.  

Danger: Correct procedures and practices need to be followed to 

avoid personal injury. The improper handling could cause hazardous 

condition, bodily injury and equipment damage could occur. 

Please careful note below information: 

Warning: It’s necessary to completely read the instruction manual 

before operating the Genizer Laser Particle Sizer. The operator should be 

familiar with all the functions and control of this system. 

Warning: Do not move the equipment when the system is running. 

Always disconnect the equipment from the power supply before moving 

or maintaining. 

Warning: Do not look directly into the laser light source, it may 

cause permanent damage on the eyes. 

Warning: The equipment or the components cannot be changed 

without authorization. 

Warning: If the interval between two tests is more than 1 hour, 
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turn off the sizer in time to avoid reducing service life of sizer (especially 

the laser). Before each test, turn on the machine 10-15 minutes in advance 

to preheat. 

Warning: Handle the equipment gently and do not put heavy 

things on the equipment. 

Attention: Keep the Genizer Laser Particle Sizer far away from 

the open fire and high temperature.  

Attention: Every time the test is finished, the sample cell shall be 

cleaned to avoid contamination or affecting test results. 

Attention: Please keep the window of the sample holder clean 

during the tests.  

 

4. Installation 
4.1 Place the particle sizer on a stable workbench, and keep a distance of 

more than one meter from other electronic equipment as far as possible to 

avoid electromagnetic interference; 

4.3 Turn on the particle sizer and preheat for 30min and then the 

computer; 

4.2 Connect the wires COM 1 and COM 2 to the particle sizer and 

computer port respectively; 

4.3 Connect the power supply; 
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5. Preparation 
5.1 Select the liquid with good dispersion as the medium. If the selected 

dispersion medium is water, it is recommended to use the newly prepared 

distilled water or deionized water. 

5.2 Make sure that the dispersion medium is pure and without impurities. 

It is better to use a filter (filter membrane with diameter 0.2μm). 

5.3 Prepare a 50ml beaker, and add about 25ml of dispersion medium and 

a proper amount of tested sample into it. 

5.4 Use the ultrasonic and homogenizer to disperse. After dispersing 

sufficiently, observe the emulsion concentration. 

5.5 Take the dispersed sample emulsion, add it to the clean sample cell, 

and cover the lid ready to be tested. 

 

6. Operation 

6.1LPSA software and port setting 

6.1.1 Plug USB KEY into computer, and then double click LPSA on the 

desktop to open analysis software;  

6.1.2 Click "Port settings" in "Parameter setting" and set the port as 

shown in Figure 1:  
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 Figure 1: Port Settings Interface 

 

6.2Sample Testing Procedure 

6.1.1 Wait for 1-2 minutes to make sure that the sample is completely still; 

6.1.2 Fill in the information of the tested sample in the “sample 

information and test condition” section, and select the name, refractive 

index, viscosity of the dispersion medium as well as the test temperature. 

(Relevant parameters of water and alcohol have already been added to the 

software. If the dispersion medium is changed, the corresponding 

parameters shall also be changed); 

6.1.3 Click "Start" in the "Run" menu or  on the toolbar to enter the 

sample test stage: 
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 Figure 2: Sample Test Interface 

 

6.1.3.1 Toolbar icons 

 Create a new file  Open the specified file 

 Save the file to  Copy the data 

 Cut the data  Paste the data 

 Print preview  Print 

 Start testing  Stop testing 

 Record data   
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6.1.3.2 Drop-down list 

   

   

  

 

 

  

 

 

Create a new file 

Open the specified file 
 

Save the file to 

Quit the program 

Cut the data 

Copy the data 

Paste the data 

Delete the data 

Take the average of the data 
Modify the relevant information 

Start testing 

Stop testing 

Record data 

Display test data 

Choose the correct port 

Choose the green light 

Set the calibration coefficient  

Print the report 

Export the report in a Word file 

Export the report in a Excel file 
 Export the report in a BMP file 
 Print preview of the report 

Save the file 

Choose the blue light 
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6.1.3.3 Composition of interface 

The interface consists of four quadrants: Sample Information and Test 

Condition, Particle Size Distribution, Correlation Function and Photon 

Counting Rate, among which "Sample Information and Test Condition" 

interface is used to record the information and test conditions of the test 

sample," Particle Size Distribution" interface displays test data and particle 

size distribution diagram, "Correlation Function" describes the 

autocorrelation curve outputted by digital correlator, and "Photon 

Counting Rate" presents the current number of scattered light photons in 

real time. Observe the correlation curve; if it isn’t the ideal one, then it can 

be adjusted by choosing different delay unit time to achieve the ideal state. 

The specific methods are as follows: 

6.1.3.3.1 Click  on the toolbar to end the test; 

6.1.3.3.2 Change the delay unit time and restart; 

6.1.3.3.3 Observe the correlation curve. If it still fails to meet the 

requirements, repeat the above operations until the ideal correlation curve 

is obtained; 

6.1.3.3.4 The ideal correlation curve is shown in the figure 3. The front 

part of the curve is on a downward trend, the latter half is in a stable state, 

View the report 

Choose the analysis mode 
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and the inflection point shall be between 100-1000; 

6.1.3.3.5 If the front part of the correlation curve drops sharply and the 

tail part of the correlation curve is too long, which means the delay unit 

time is too long. Therefore, a shorter delay unit time shall be selected. But 

if the stable part of the curve tail is too long, i.e. the inflection point drops 

and data over 1000, it means that the delay unit time is too short, and a 

longer delay time shall be better; 

6.1.3.3.6 The principle is to select long delay unit time for large particles 

and short for small particles. 

 
 Figure 3: The Ideal Correlation Curve 

6.1.4 After getting the ideal correlation curve and the test result is stable, 

click  on the toolbar to record test results; 

6.1.5 Click "End" in the "Run" menu or  on the toolbar to end the 

test; 

6.1.6 Click the blank space to view the test results. 
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6.2 Data Processing 

6.2.1 Data Deletion  

To delete unfavorable records, select the records and then click "Delete" 

on the "Edit" menu, or press the Delete key on the keyboard to delete 

directly. 

6.2.2 Data Modification 

If the sample information and test condition is not filled in before the test, 

the recorded data can also be modified. When modifying, select the data to 

be modified, click "Modify" on the "Edit" menu, or right-click the mouse 

to select "Modify" to open the information modification interface. 

 

 Figure 4: Information Modification Interface 
 

6.3 Repeatability of the Test Result 

6.3.1 Select the data record; 
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 Figure 5: Data Selection 

6.3.2 Click "Repeatability" on the "Analysis" menu to pop up 

repeatability interface which shows standard deviation, average particle 

size and repeatability, then click "average particle size report" to view the 

average data value of the selected record. 

 
Figure 6: Repeatability Interface 

 

6.4 Print Preview 

Double click for opening the record you want to preview, and click "Print 

preview" on the "Print" menu or  on the toolbar. 
 

6.5 Print 

Double click for opening the record you want to print, click "Print" on the 

"Print" menu or  on the toolbar or a simple Ctrl+P keyboard 
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shortcut to print. 

Attention: A4 paper is required for printing test report. 

 

6.6 Test Report Export 

In the test report or print preview interface, click options in the "Print" 

from drop-down menu to export test reports in Word, Excel and BMP 

formats. 

 

6.7 Save Data 

After test data recording, click "Save" on the "File" menu or  on the 

toolbar or Ctrl+S keyboard shortcut to pop up "Save" interface. Select the 

saving path, input the file name, and click "Save" to save the current 

record list. The suffix of the saved file is ". wcr". 
 

6.8 Laser Switch 

Click "Green Light Switch" or "Blue Light Switch" in "Parameter setting" 

to choose the light. 

Light selection guidance: The optimum photon counting rate is ~40 for 

green laser and ~10 for blue laser. Choose the green light to test at first. If 

the photon counting rate of the sample is always 1-2, which means that the 

sample may absorb light, it needs to switch to blue light. 
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6.9 Calibration Method 

6.9.1 Click "Calibration coefficient setting" in the "Parameter setting" 

menu to open the popup window, as shown in Figure 8. In "Calibration 

method 1", input standard sample value and test value directly and then to 

click "Setting". If choosing "Calibration method 2", calculate the 

calibration coefficient first and then fill in it and click "Setting"; 

ValueTest
ValueSamplendardStatCoefficiennCalibratio =

 

 

Figure 8: Calibration Interface 

6.9.2 After adjustment, repeat measurements several times, observe the 

stability of the measurement results. If the requirements are as expected, 

the calibration is completed. 
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6.10 Temperature Display 

 

The required working temperature can be manually preset on the 

enclosure panel, which makes it more intuitive. 

 

7. Maintenance 
7.1 Please clean the sample cell before closing the system. Do not let the 

material stay for a long time. 

7.2 Attention    : Service or maintenance work is prohibited when 

the system is running. 

7.3 Attention    : Ensure the power supply has been turned off safely 

before implementing the service or maintenance work. 

 

8. FAQ 
If the LPSA software does not respond within 10 minutes, please close 

the software and restart it after a few minutes. 
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Detailed Internal Diagram of the GDPS 
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Note: 1. The specification, structure and parameter may be modified 

without notification.  

2. The Dimensions, structure and parameter should be subject to 

the final product. 

List of components 
Item Description Function 

1 Power Switch When pressed, the power is on and the indicator 
light is on 

2 Fuse Electric Leakage protection 
3 Power Socket Power cord connection socket 
4 COM 3 Laser switching port 
5 COM 2 Control port for computer control of instruments 

6 COM 1 
Sampling port for data communication between 

instrument and computer 
7 Cooling Fan Cool the internal components 
8 Lens-2 Refraction for light 

9 Digital Correlator Obtain autocorrelation function of dynamic 
scattering light 

10 Photomultiplier Tube Receive scattered light signal and convert it into 
electrical signal 

11 Laser Device 1  Output green laser 
12 Laser Device 2  Output blue laser 
13 Lens Converging laser beam 
14 Sample Holder Hold the sample 

15 Thermostat Module Control the temperature of sample holder to be 
constant 

16 Temperature Controller Control the thermostat module 

17 Laser and Photomultiplier 
Tube Power Supply Power the laser device and photomultiplier tube 

18 24v Switching Power Supply Supply DC24v 


